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Welcome to a new world of adventure. Your new 
StarShoot Solar System Color Imaging Camera (SSSSI) is 
capable of capturing detailed, full-color images of astro-
nomical objects in our solar system. The planets, Moon, 
and Sun (with optional solar filter) can all be imaged to 
create spectacular views on your computer which can be 
saved for emailing or printing later. The SSSSI can even be 
used during the day to take images of terrestrial subjects. 
You’ll find that this inexpensive, yet easy to use, camera 
will enhance all of your journeys with your telescope. 
Please read this instruction manual before attempting to use the camera or 
install the needed software. For the most detailed information on specific cam-
era and software functions, consult the Maxim DL Essentials Help menu.

Parts list
•	 StarShoot	Solar	System	Color	Imaging	Camera

•	 Parfocal	ring

•	 CD-ROM

System requirements (refer to Figure 1)

telescope
The SSSSI can be used with virtually any telescope that is compatible with 
1.25" format eyepieces. The camera simply is inserted into a focuser in 
the same way as a standard eyepiece (Figure 2). If you use a star diago-
nal, you should remove it. In order to reach focus, the telescope must 
have approximately 0.6" (15mm) of inward focus travel relative to where 
a standard eyepiece focuses. If your telescope does not have enough 
inward focus travel, you will need to use and optional 1.25" barlow lens 
to extend the telescope’s focal plane to the camera’s imaging plane. 

For most types of astro-imaging with the SSSSI, using a telescope with a focal 
length of at least 1000mm is recommended. Otherwise, the image scale may 
be too small. To increase the effective focal length of your system, use a bar-
low lens or other type of tele-extender lens.

Figure 1: To use the SSSSI, a telescope, mount, and computer are required.

Figure 2: The SSSSI fits into 1.25" focusers, just like a standard 1.25" eyepiece.
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Mount
An equatorial mount is not absolutely required for imaging with the SSSSI, as 
the maximum exposure time is 0.5 seconds, too short for astronomical objects 
to drift significantly during the exposure. Use a sturdy mount that is appropri-
ately sized for the telescope tube being used.

For obtaining the best planetary images, however, we do recommend an equa-
torial mount. Planetary imaging requires combining many individual images, 
and having an equatorial mount will prevent the planet from drifting out of the 
field of view of the camera during the time it takes to acquire the large number 
of images necessary. A motor drive (single-axis) is recommended too.

Computer
A computer is also needed. For astro-imaging in the field at night, a laptop 
computer is highly recommended. Maxim DL Essentials requires Windows 98™, 
Windows ME™, Windows NT™ 4.0, or Windows 2000™ (or higher). 

The following hardware is required:

•	 Processor	–	Pentium™ or equivalent, or higher 

•	 Recommended	minimum	memory	size	is	64	MB.	

•	 Disk	Space	–	67	MB	for	program	installation,	100	MB	swap	file	
recommended

•	 Video	Display	–	800	X	600,	16-bit	color	or	higher.	1024x768	or	higher	is	
recommended. 

•	 Mouse

•	 Internet	Explorer	4	or	higher	required	to	display	on-line	help

•	 USB	port	(USB	2.0	recommended)	

Note that Maxim DL Essentials benefits greatly from increased memory size. 

Software and Driver Installation
Before the camera can be used, software and a camera driver must be 
installed onto your computer. Turn on your computer and allow the Windows 
operating system to load as normal. Insert the included CD-ROM into your 
computer’s CD-ROM drive, and the Launcher will appear (Figure 3). This allows 
you to install the Maxim DL Essentials software, and the Orion StarShoot Solar 
System Imager camera driver.

Software Installation
1. To install Maxim DL Essentials Edition, insert the CD-ROM into the drive. 

The Launcher will appear.

2. Click Install.

3. The InstallShield Wizard will start. Click Next.

4. Read the Maxim DL License Agreement. If you agree with the terms, then 
select I accept the terms in this license agreement and click Next. 

5. You are now ready to install. Click Install. The installation will proceed.

6.	 Microsoft	DirectX	9	or	higher	is	required.	Click	Yes to install the update.

7. The installation is now complete. Click the Finish button.

You can launch Maxim DL Essentials Edition using the desktop icon, or using 
the Windows Start menu.

Camera Driver Installation
Now that the software is installed, the camera driver must also be installed. Do 
not connect the SSSSI to your computer yet.

1. Return to the Launcher and click Install Driver.

2. The InstallShield Wizard appears. Click Next.

3. The installation will commence.

4.	 If	you	have	XP	Service	Pack	2	or	higher	 installed,	you	will	get	a	warning	
message about an update not being necessary. This is normal operation; 
just click OK.

5. When the wizard is complete, click Finish. You may be prompted to restart 
Windows. If so, close all other applications and click OK. 

Figure 3: The Launcher provides an easy menu for software 
installation.
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This has installed the driver software; next we must install the camera itself. 

6. Plug in the camera into your computer’s USB port. The Found New 
Hardware Wizard will appear (Figure 4). Select Install the software auto-
matically (Recommended) and click Next. The driver will start installing.

Note: For best results, use a USB 2.0 port. If you only have USB 1.1, the cam-
era will run slower and you may have reduced (320x240) resolution. We highly 
recommend upgrading to USB 2.0 if you have USB 1.1. A USB upgrade card 
can be found from a computer parts supplier.

7. Windows will note that the driver is not signed. This is normal. Click the 
Continue Anyway button.

8. When the installation is complete, click Finish. 

You are now ready to use the camera. If Maxim DL Essentials Edition is already 
running, then close the software and restart it. The Camera Control Window 
will now appear along with the Live Video window (Figure 5). 

Once the driver is installed, the computer will recognize the SSSSI whenever 
it is plugged in.

Getting Started During Daylight 
We recommend using the SSSSI for the first time during the day. This way, 
you can become familiar with the camera and its functions without having to 
stumble around in the dark. Setup your telescope and mount so the optical 
tube is pointing at an object at least a couple of hundred feet away. Insert an 
eyepiece and focus as you normally would.

To obtain first images with the SSSSI, follow these step-by-step instructions:

1. Plug the camera into your computer’s USB port.

2. Open Maxim DL Essentials by clicking on the icon now installed on your 
computer’s desktop.

3. Once open, Essentials should connect directly to your camera with a Live 
Video Window and Camera Control Window. Your Live Video Window will 
only show light and dark before the camera is coupled to your telescope. 

4. To connect the camera to the telescope, simply replace the telescope’s 
eyepiece with the camera. Make sure the securing thumbscrew on the 
focuser drawtube is tightened. 

Figure 5: The Live Video window and Camera Control Window 
both automatically appear when the SSSSI is connected to the 
computer and the Maxim DL Essentials program is opened.

Figure 4: When initially connecting the SSSSI to a computer, 
the Found New Hardware Wizard will appear and guide you 
through driver installation.
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5. You will now need to refocus the camera for the centered object. Focusing 
will be the hardest thing to learn in the initial stages. If you are starting 
out in daylight, as is recommended, turn the brightness control of the 
camera down before attempting to focus. This is done by clicking on the 
Setup button in the Camera Control Window. First, select Video Capture 
Filter, then the Video Image tab, and under Exposure make sure the Auto 
box is checked. Then adjust the Contrast and Brightness on the Video 
Proc Amp tab. Also, for daytime use we recommend opening the Screen 
Stretch Window (in the View menu), and setting the stretch mode to Moon. 
If the daytime image brightness is still too bright to produce an acceptable 
image on your computer screen, you may need to stop-down the aperture 
of your telescope.

6. Now, turn the telescope’s focus knob so the focuser drawtube moves 
slowly inward. The drawtube needs to go approximately 15mm inward from 
where the eyepiece focuses (for most eyepieces). Look at the computer 
screen and adjust the focus knob accordingly to determine best image 
focus.

Note: The camera’s field of view is fairly small. It is approximately equivalent to 
the field of view through the telescope when looking through a typical (i.e. not 
wide-field) 5mm focal length eyepiece.

7. Image orientation can be changed by rotating the camera within the 
focuser drawtube. Simply loosen the thumbscrew on the drawtube and 
rotate the camera until the desired image orientation is achieved. Retighten 
the thumbscrew on the focuser drawtube when done. You may need to 
slightly refocus (using the telescope’s focus knob) if the focuser drawtube 
has moved a bit inward or outward when the camera was rotated.

8. Select Light Color 1x1 mode in the Camera Control Window. 

9. Set Frames to 1 in the Camera Control Window. You can increase this 
number to automatically add successive frames into the resultant image 
for higher image quality. If the object is moving due to poor atmospheric 
seeing conditions, wind, or a shaky mount, however, increasing the Frames 
to more than 1 will generally decrease image quality. You can take many 
individual frames and add them together (“stacking” or “combining”) later, 
this will be discussed in detail in the “Astronomical Imaging” section.

10. Beneath Mode in the Camera Control Window select Single shot mode.

11. Turn off Dark Subtract (make sure box is unchecked) in the Camera 
Control Window. 

12. Click the Expose button in the Camera Control Window. An image will 
appear in a window. 

13. You can now save the image for later processing, if you wish. This is done 
by selecting Save from the File menu.

You have now taken your first picture with the SSSSI! This simple method 
of imaging is exactly how the camera is used to capture terrestrial subjects 
during daylight hours. Close-up images of birds and other wildlife or faraway 
vistas can all be obtained in this way with the SSSSI. Solar images can also 
be taken during the day with an optional full-aperture solar filter over the front 
of the telescope. 

Take some time to use the camera and Maxim DL Essential software during the 
day to become familiar and comfortable with their basic operation. For best 
results, you can optimize your images with the camera controls.

Camera Controls
For best images, you can adjust the camera controls though Maxim DL 
Essentials to fine tune the image. You can see how the camera controls affect 
an image in the Live Video window. 

In the Camera Control Window, click the Setup button, then choose Video 
Capture Filter and you can access the camera controls. Under the first tab 
(Video Proc Amp), you will find the Brightness, Contrast (best at 50% or high-
er), Saturation (level of color), Sharpness (keep this low as it can add noise), 
and Gamma (which you should leave at around 30-34) controls. The second tab, 
Video Image, has options for the Light Source (in most cases should be set to 
Daylight – Outdoors), White Balance (which can be left on Auto), Exposure, 
and Optimization (leave on better quality unless your computer is older and the 
video is making things really slow). You can also use the Flip Vertical and Flip 
Horizontal check boxes to change the image orientation. 

The Exposure control allows you to vary the length of time of image exposure. 
A longer exposure will help bring out fainter detail, but may cause brighter 
areas of the image to become washed out. This control can be adjusted from 
1 to 50 (less if using USB 1.1); this is a logarithmic adjustment with 1 corre-
sponding to the shortest exposure (0.0001 second) and 50 corresponding to 
the longest exposure (0.5 seconds).

For the Exposure control, you can either manually adjust (by unselecting the 
Auto box and manually moving the slider), or have automatic adjustment by 
leaving the Auto box selected. If Auto is selected, you can use the slider to 
set the relative Auto Exposure Level desired. If there is a significant dark area 
in the camera’s field of view, for best results leave the Dark Area box selected 
when Auto is selected.

The other camera controls are available by clicking the Setup button, and 
selecting Video Capture Pin. Here you can adjust Frame Rate (which will 
always stay the highest it can go unless using USB 1.1), Color Space/
Compression (leave on I420), Output Size (which will be the size of the final 
image and can be changed form 640x480 down to a small 160x120) and 
Quality (leave at the highest).
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Try several different settings to get a feel of how the camera controls work and 
affect the resultant image on the computer screen. The brightness and exposure 
are the controls you will use the most. The telescope being used, seeing condi-
tions, and object being imaged will dictate how these camera controls should be 
set. Usually exposure will be set first, then brightness is adjusted as needed. 

Screen Stretch Window
The function of the Screen Stretch Window (Figure 6) is to properly map the 
image brightness levels captured by the camera into corresponding image 
brightness levels on the computer screen. A typical camera image has each 
pixel (light detecting site, over 300,000 pixels form a single SSSSI image) rep-
resented as a number depending on brightness. This has to be mapped into 
the video monitor’s brightness range. It is important to set the screen stretch 
appropriately, or a great image may look terrible!

Note: The Screen Stretch Window does not work for the Live Video window, 
only for open images captured by the camera.

In the Screen Stretch Window, you will notice a graph. This is called the “his-
togram” of the currently displayed image (Figure 7). 

A histogram is a simple bar graph that shows the range of brightness in an 
image. Each bar in the graph represents a level of brightness; the bar to the 
far left in the histogram represents the dimmest pixels, and the bar to the far 
right is for the brightest pixels. The height of the bar is the total number of 
pixels at that brightness level in the image. Every image has a different histo-

gram depending on how much of the image is bright or dark. Directly viewing 
the histogram of your image in the Screen Stretch Window provides an easy 
interface for making decisions on how the screen stretch should be set.

In Maxim DL Essentials, the two parameters entered in the Screen Stretch 
Window are Minimum and Maximum. A pixel that is at the Minimum value is 
set to zero (black), and a pixel at the Maximum value is set to 255 (white). An 
easy way to adjust the Maximum and Minimum values is to move the slider 
arrows located directly under the histogram of the image in the Screen Stretch 
Window. The red slider arrow corresponds to the Minimum value and the 
green arrow corresponds to the Maximum value. Simply left-click and then 
drag each arrow to adjust it to the desired level. The best results are obtained 
by tweaking the arrows (numbers) until the most pleasing display appears. 

There are also seven automatic settings in the Screen Stretch Window. 
Typically, Moon and Planet will give the best results. The default screen stretch 
setting is Moon.

Instead of using the Screen Stretch Window, it is faster to use the Quick 
Stretch facility. This allows you to modify the image appearance instantly with 
small up/down and left/right movements of the mouse. To do this, hold down 
the Shift key, then left-click and drag the mouse on the image. You’ll find this 
feature to be a great convenience when fine adjusting the screen stretch to get 
an image to look its best.

The problem with stretching is determining exactly how to stretch the image for 
best effect. Often there are several different possibilities for the same image. 
Trial-and-error will be the best way to judge what the best screen stretch set-
ting is. Try several different settings until you find one you think looks best. 
When the image is subsequently saved, the screen stretch setting information 
will be kept when the image is next opened.

use of the Parfocal ring
A parfocal ring is included with your camera to help with focusing. The ring is 
intended to be used with a 1.25" eyepiece (not included), preferably one with a 
focal length of at least 10mm to provide high enough magnification for precise 

Figure 7: A histogram is a visual 
representation of the range and level of 
brightness in an image.
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Figure 6: The settings in the Screen Stretch Window greatly 
determine how an image will appear on your computer screen.
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focusing. The ring goes on the barrel of the eyepiece. When the ring is properly 
positioned on the barrel, you can use the eyepiece to focus, replace the eye-
piece with the camera, and the camera should be close to focused.

To properly position the parfocal ring on the eyepiece barrel, first insert the 
camera into the telescope’s focuser drawtube. Set Maxim DL Essentials so 
the camera displays on the computer’s screen in live preview mode. Focus 
the camera as precisely as possible by visual inspection of the image on your 
computer screen. You do not need to actually capture an image, just look at 
the live preview on the computer. If you have a focus lock thumbscrew on 
your telescope’s focuser, tighten it firmly once sharp camera focus is achieved 
(Figure 8a). Place the parfocal ring on the eyepiece barrel, and slide it up the 
barrel as far as it will go and loosely tighten the thumbscrew on the ring (Figure 
8b). Now, replace the camera with the eyepiece, being careful not to change 
the position of the focuser drawtube. Bring the eyepiece into focus by sliding 
it in and out of the focuser drawtube (Figure 8c). Do not use the focus knob of 
your telescope to focus at this time. 

Note: If you cannot obtain a focus with the eyepiece by pulling it out of the 
focuser drawtube, you will need to try another eyepiece. 

When the eyepiece is in focus, tighten the securing thumbscrew on the focuser 
drawtube to secure the eyepiece in that position. A significant portion of the 
eyepiece’s barrel should be extending out from the focuser drawtube. Now, 
slide the parfocal ring down the eyepiece barrel, and seat it against the focuser 
drawtube (Figure 8d). Securely tighten the thumbscrew on the ring. The parfo-
cal ring is now properly positioned on the eyepiece’s barrel.

Now that the parfocal ring is properly positioned, focus the camera by first 
focusing with the eyepiece. Simply insert the eyepiece as far as it will go 
into the focuser drawtube, and focus with the telescope’s focusing knob. 
Then, replace the eyepiece with the camera, and the images on the computer 
screen should be very close to focused. Use the live preview mode to achieve 
a precise focus with the camera. You’ll find that using the parfocal ring on an 
eyepiece will serve to focus the camera much more quickly. 

astronomical Imaging
Now that you’re familiar with basic camera and software operation, it’s time 
to take the SSSSI out at night under the stars to capture some astronomical 
images. We recommend starting with the Moon, as it is easy to acquire into 
the camera’s field of view, and typically does not require stacking of multiple 
exposures as planetary images do.

Imaging the Moon
Imaging the Moon is much like imaging terrestrial objects during the day. Since 
the exposure is very short, it is not critical that the telescope be precisely polar 
aligned. Best focusing will be achieved by first focusing on a bright star near 
the Moon.

When the moon is past half full, it is hard to get detail due to the tremendous 
glare off of the lunar surface. Most detail, even on a sliver of a moon, will be 
at the terminator (that tiny thin line between the shadow and light, see Figure 
9). To get more of the moon in the image, a focal reducer will need to be used. 
For close-ups of craters use a barlow lens (see “Using Focal Reducers and 
Barlow Lenses”). 

Figure 8a-d: (8a.) To properly set the position of the parfocal ring on an eyepiece, 
first focus the camera in the telescope. If you have a focus lock thumbscrew on your 
telescope’s focuser, tighten it. (8b.) Place the parfocal ring on the eyepiece’s barrel 
and slide it all the way up. Tighten the thumbscrew on the ring. (8c.) Remove the 
camera, and focus the eyepiece by sliding it in-and-out of the focuser drawtube. When 
eyepiece focus is achieved, tighten the thumbscrew on the focuser drawtube to secure 
the eyepiece in that position. (8d.) Now, loosen the thumbscrew on the parfocal ring, 
slide the ring all the way forward, and retighten the thumbscrew on the ring.

8a

8c

8b

8d

Focus lock 
thumbscrew

Parfocal ring

Focuser drawtube 
thumbscrew

Parfocal ring 
thumbscrew

Figure 9: The Moon’s surface detail 
looks the best along the terminator.



14 15

Imaging Planets
The best planetary images will be obtained by stacking (combining) many indi-
vidual images in order to improve image contrast, brightness, and detail. 

Since you will be taking multiple images over a period of time, it is important 
you have a decent polar alignment in order to keep the planet within the field of 
view of the camera. To this end, having a motor drive (at least single-axis) will 
also be helpful. Otherwise, you will periodically need to rotate the R.A. slow-
motion knob to keep the planet within the camera’s field.

To take multiple images of a planet for stacking:

1. Acquire the planet into the field of view of your eyepiece that has the parfo-
cal ring attached to it, and center it in the eyepiece’s field of view. Focus 
the eyepiece with the telescope’s focuser. If you are using an equatorial 
mount with a motor drive, make sure the motor drive is on and engaged.

2. Now, remove the eyepiece and replace it with the SSSSI. If the parfocal 
ring was set properly on the eyepiece, the camera should be close to 
focused.

3. Focus the camera using the telescope’s focus knob. If you are having trou-
ble determining best focus, try focusing on a bright star near the planet. 
You can also use the histogram functions for most accurate focus, this will 
be explained later.

4. In the Camera Control Window, set the Mode to Light Color 1x1.

5. Set Frames to somewhere between 1 and 10 to start. This number indi-
cates the number of frames Maxim DL Essentials will actually put into 
each individual captured image. Be careful not to set this number to high, 
especially if seeing conditions are poor. Otherwise, the captured images 
will be blurry.

Note: The Frames setting is not meant to replace stacking of resultant images. 
It simply puts more data into each image by overlaying subsequent frames on 
top of each other. These images are then stacked as described later.

6. In the box beneath the Mode box, choose Autosave. Now set the number 
of images you would like the camera to take under Autosave, select the file 
folder in which you would like to save the images with Folder, and enter in 
a Base filename for the captured images. Typically the name of the object 
being imaged, such as “Mars1”, will be entered here. If “Mars1” is the Base 
filename, and you choose to Autosave five images, then the images will 
appear in the selected file folder as “Mars1_0001.fit”, “Mars1_0002.fit”, 
“Mars1_0003.fit”, “Mars1_0004.fit”, and “Mars1_0005.fit”.

7. Click Expose, and the camera will commence taking the images.

Now that we have multiple images of the planet, we will combine the images 
to form one high-quality resultant image. To do this:

8. Select Open from the File menu. Find the folder you indicated with Folder, 
open it, and select all images for stacking using the mouse left-click and 
the Shift key. All of the individual images selected will open in Maxim DL 
Essentials.

Note: In order to combine images, the images must first be opened in Maxim 
DL Essentials.

9. Select Combine from the Process menu. In the pop-up window, you will 
see all of the images currently open in Maxim DL Essentials. Choose the 
individual images you want to stack and press the >> button, or simply 
click Add All. Click the OK button when done.

10. The Combine Images window will appear (Figure 10). For Align Mode, 
choose Planetary. In the Output box, select Average. 

11. Now, you can see how each individual image looks by using the Next 
Image and Previous Image buttons. If you see an image that looks poor, 
you can reject it from the stack by clicking the Reject Image button.

Note: At least one image must be used as the reference image for the stacked 
images to be overlaid upon. The default uses the first image for the reference 
image. If you reject the first image or otherwise want to use another image as 
the reference, click the Set As Reference button when the desired reference 
image is actively displayed. If the image currently chosen as the reference is 
rejected from the stack, and another reference image is not selected, you will 
not be able to Overlay All Images.

Figure 10: The Combine Images window allows “stacking” of 
individual images into one high-quality resultant image.
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12. Now, click the Overlay All Images button. All of the selected images will 
stack on top of each other to form one resultant image. Click OK.

You have now composed your first planetary image. Use Save under the File 
menu to save your image at this time. To make it look its best, you will want 
to adjust the Screen Stretch Window to Planet. You may also want to do 
some image processing, see the section entitled “Image Processing” for more 
information.

Imaging Planets: recording Video
In the prior section, individual images of a planet were auto-saved for sub-
sequent stacking later. Another way to obtain images for stacking is to take 
several seconds of video of the planet, then break the video into individual 
frames for stacking. Since the SSSSI has a maximum frame rate of 30 frames 
per second, you can literally obtain hundreds of images for stacking within 
just a few seconds! You save time by taking one video instead of dozens of 
individual pictures!

To record a video of the planet:

1. Acquire the planet into the field of view of your eyepiece that has the parfo-
cal ring attached to it, and center it in the eyepiece’s field of view. Focus 
the eyepiece with the telescope’s focuser. If you are using an equatorial 
mount with a motor drive, make sure the motor drive is on and engaged.

2. Now, remove the eyepiece and replace it with the SSSSI. If the parfocal 
ring was set properly on the eyepiece, the camera should be close to 
focused.

3. Focus the camera using the telescope’s focus knob. If you are having trou-
ble determining best focus, try focusing on a bright star near the planet. 

4. In the Camera Control Window, set the Mode to Video. Set Seconds to 
correspond with the video length. Remember, the camera takes 30 frames 
per second. So if you want 150 individual frames for stacking, set Seconds 
to 5.0.

5. Click the Setup button in the Camera Control Window. Choose Output 
File from the pop-up menu and select the file location where you want the 
.avi video saved to. Type in a name for the file in File name. Click Save.

6. Now, click Expose, and the SSSI will commence taking the video. The 
image as it appears in the Live Video window is exactly what will be 
recorded. If you wish to play back the video, click on the .avi file from its 
recorded file location.

Now that we have a video of the planet, we will break the video up into its 
component images for stacking. To do this:

7. From the File menu, choose Open or Convert AVI File. The Open or 
Convert AVI File window will appear (Figure 11).

8. Select the file location of the .avi video saved prior. At the bottom left of 
the Open or Convert AVI File window, in the Action box, select Open as 
individual images. (Alternatively, the Convert to BMP files selection in the 
Action box breaks the video into individual frames and saves them for 
opening and processing later.) At the bottom right of the Open or Convert 
AVI File window you can select the video frame number to start with (usu-
ally will be 0) and the number of frames to break out into individual images. 
Use caution, however; opening many hundreds of frames at once can be 
confusing and burdensome. Click Open.

Now that we have multiple images of the planet, we will combine the images 
into a single image. To do this:

9. From the Process menu, select Combine.

10. In the Select Images window, click Add All. Then click OK.

11. The Combine Images window will appear. For Align Mode, choose 
Planetary. In the Output box, select Average.

12. Now, you can see how each individual image looks by using the Next 
Image and Previous Image buttons. If you see an image that looks poor, 
you can reject it from the stack by clicking the Reject Image button.

Note: At least one image must be used as the reference image for the stacked 
images to be overlaid upon. The default uses the first image for the reference 
image. If you reject the first image or otherwise want to use another image as 
the reference, click the Set As Reference button. If the image currently chosen 
as the reference is rejected from the stack, you will not be able to Overlay All 
Images.

13. Now, click the Overlay All Images button. All of the selected images will 
stack on top of each other to form one resultant image. Click OK.

Figure 11: The Open 
or Convert AVI File 
window breaks video 
into individual images for 
subsequent stacking.
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Adjust the Screen Stretch Window to Planet, and use Save under the File 
menu to save your image. You can now perform any wanted imaging process-
ing.

Dark Frames
A way to coax additional image quality out of the SSSSI is to eliminate 
unwanted camera “noise” from captured images. While this will generally not 
be needed for most types of imaging with the SSSSI, it may help to improve 
image contrast in some cases.

To do this, “dark frames” must first be captured and averaged. Dark frames are 
taken with no external light entering the camera. The image produced is a map 
of the actual noise in the frame being produced by the camera. When a dark 
frame is subtracted from a regular (“light”) image, the noise in the resultant 
image is reduced. You will find, however, that the short exposures that can be 
taken with the SSSSI will not contain much camera noise to begin with. So, 
subtracting dark frames from images (prior to combining) will not have a great 
effect on resultant images.

Note: To most effectively use dark frames to subtract noise out of resultant 
SSSSI images, it is important to take dark frames close to the actual time of 
taking the “light” images. This is because temperature changes will cause the 
noise pattern in the SSSSI to change over time. So, it is best to take some dark 
frames immediately before or after the “light” images are taken. 

To take dark frames for subtraction from “light” images:

1. In the Camera Control Window, set the Mode to Dark Color 1x1.

2. Set Frames to whatever you set it to for taking actual (“light”) images.

Note: When taking dark frames, do not change any of the settings in the Setup 
button from what they were (or will be) when “light” images are taken.

3. In the box beneath the Mode box, choose Autosave. Now set the number 
of dark frames you would like the camera to take under Autosave (three 
to ten will generally suffice, these will be averaged together), select the 
file folder in which you would like to save the dark frames with Folder, 
and enter in a Base filename for the captured dark frames. Typically the 
name of the object being imaged with the word “dark” added, such as 
“Mars1dark”, will be entered here. If “Mars1dark” is the Base filename, 
and you choose to Autosave five images, then the images will appear 
in the selected file folder as “Mars1dark_0001.fit”, “Mars1dark_0002.
fit”, “Mars1dark_0003.fit”, “Mars1dark_0004.fit”, and “Mars1dark_0005.
fit”. Using the word “dark” in the Base filename will help you distinguish 
between light and dark frames when combining later.

4. Click Expose, and Maxim DL Essentials will indicate that the camera needs 
to be covered to take a dark frame. Cover the front of the lens you are 
imaging through, and then click OK. The camera will commence taking and 
saving the dark frames.

Now that we have acquired several dark frames, we will combine them into a 
single averaged dark frame for subtraction from subsequent “light” images.

5. In the Process menu, select Setup Dark Subtract. 

6. In the window that pops-up, click Remove All if any filenames appear in 
the  window.

7. Click Add, and select the file folder location for the dark frames taken. 
Select the dark frames and click Open.

8. The selected dark frames will now appear in the pop-up window. Click 
OK.

We are now ready to subtract the averaged dark frame from “light” images. 
This should be done to individual light images BEFORE combining them 
together. There are two ways to do this. If you take dark frames first, before 
taking “light” images, then you can automatically subtract the averaged dark 
frame from each individual “light” image as it is captured. If you take dark 
frames after you have already taken the “light” images, then you can subtract 
the averaged dark frame from each individual image before you combine them 
into a single, final resultant image.

To automatically subtract the averaged dark frame from images as they are 
captured, first setup the averaged dark frame as outlined previously. Now, in 
the Camera Control Window, simply click the Dark Subtract square so it is 
checked. Once this box is checked, every subsequent light frame taken with 
the camera will have the averaged dark frame automatically subtracted. These 
images are ready for  stacking.

If you have already taken your “light” images or obtained individual images by 
recording video, then you will need to manually subtract the averaged dark 
frame from each image prior to stacking them into one combined image. To 
do this, first open all “light” images to be stacked in Maxim DL Essentials. Do 
this with the Open command in the File menu. Now, click on one of the opened 
images, and select Dark Subtract from the Process menu. The averaged dark 
frame is now subtracted from the “light” image. Repeat this process for all of 
the “light” images opened in Maxim DL Essentials. The individual images are 
now ready for stacking. You can save each image after the dark frame has 
been subtracted (using Save from the File menu), or you can just save the final 
combined image once the individual images have been stacked.

Image Processing
After you have captured and combined individual images (with or without dark 
frame subtraction) into a single resultant image, you may want to perform 
some additional image processing to bring out subtle details or to make the 
image appear more pleasing overall. Maxim DL Essentials contains several 
functions which serve to do this.
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Make Pixels Square
This command provides a one-step adjustment of the image aspect ratio. 
It uses the pixel aspect ratio determined by the file header and interpolates 
the image to make the aspect ratio 1:1. This generally has a very mild affect 
when applied to images. For best results, this function should be applied to 
individual images before stacking (for best image alignment), but can be used 
after stacking as well.

To use this function, simply select Make Pixels Square from the Process menu 
for any image currently opened in Maxim DL Essentials.

unsharp Mask
An Unsharp Mask is fairly simple in concept. First, a copy of the original image 
is smoothed (low-pass filtered) to create the mask. This mask is then scaled 
down in intensity by some factor (usually 50-95%), and then subtracted from 
the original image. The result of subtracting a blurred copy of the image from 
itself is to make a sharper image. This works because you are partially remov-
ing parts of the image that are smoother, while leaving untouched the parts 
of the image with fine detail. Usually the math is adjusted so that the average 
pixel values in the final image are the same as the original. 

To apply Unsharp Mask to an image:

1. Select Unsharp Mask from the Process menu.

2. In the pop-up window (Figure 12), the Low-Pass Filter can be set to Mild 
or Strong.

3. The Mask Weight is used to control the strength of the mask. The mask 
weight is in percent; the higher the number, the stronger the mask. 

4. Click on the Auto Full Screen preview button, and adjust the settings. This 
allows you to rapidly adjust the settings until you are satisfied with the 
results. 

5. Click OK when the preview images looks its best.

It is best to use a light touch with this command, to avoid over-processing the 
image. Over-processing can create artifacts; i.e. features in the image that are 
not real. It also amplifies the noise in the image.

Color Balance
The sensitivity of most CCD cameras as a function of wavelength (color) is dif-
ferent from the response of the human eye. The filters used for creating color 
composites also have their own characteristics, as do the telescope optics. 
Although “perfect” color rendition is an elusive if not impossible goal (all indi-
viduals see colors slightly differently), it is straightforward to get “good” color 
balance with simple weightings. This is where the Color Balance command (in 
the Process menu, Figure 13) comes in handy to touch up the resultant colors 
in your images. Use the Preview Image to see how altering these parameters 
will affect your image (or click the Full Screen button to see the changes 
applied to your full image).

Color images from CCD cameras typically require a background level adjust-
ment. This is accomplished by bringing the background level (or bias) in each 

Figure 12: The Unsharp Mask function can help bring out 
subtle detail in an image.

Figure 13:  The Color Balance command allows weighting of 
each color plane to improve the overall color appearance of an 
image.
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color plane down to zero. Each of the Background Level values is subtracted 
from every image pixel in its color plane. Any pixel values that become nega-
tive are forced to zero. The Auto button automatically determines the settings 
necessary to equalize the image background in all three color planes. The 
Reset button resets the background level subtraction to zero on all planes.

Scaling adjustment (percent) allows you to compensate for transmittance dif-
ferences	between	the	filters	used	to	acquire	the	three	color	planes.	Values	of	
100% result in no change. The scaling percentages can be typed in or adjusted 
using the “spin” controls (small up and down click arrows to the right of the 
scaling numbers). The Preview Image is particularly helpful in monitoring the 
results when using the spin controls. The Reset Scaling button resets to 100% 
on all three planes.

The Click On White Area to Set Scaling check box enables the operation of 
the mouse to set the scaling. Set the Background Level first (you can use 
Auto), then click on a white object (e.g. a neutral-colored star) in the image (not 
the Preview Image) with the mouse. The Scaling settings will automatically 
be adjusted to make the selected point appear white. If an area of the image 
is known to be white (or gray), this is an easier way to determine the scaling 
factors, and can be used to instantly color balance the image. 

Stretch
The Stretch command (located in the Process menu, Figure 14) modifies the 
brightness and contrast, and optionally the range (maximum and minimum 
pixel values) of an image. Unlike the screen stretch settings in the Screen 
Stretch Window, which only affects the how an image appears on the display, 
the Stretch command actually changes the image data pixel values in the 

memory buffer. In reference to the histogram, the Screen Stretch Window 
changes how the histogram is displayed on the computer screen, the Stretch 
command alters the histogram itself.

There are three elements which must be set: the Permanent Stretch Type, the 
Input Range, and the Output Range. You can use the Preview Image to see 
how changing these parameters will affect the resultant image (or click the 
Full Screen button to see the changes applied to your actual image). You can 
also open the Screen Stretch Window to see how changing these parameters 
change the histogram.

For the Permanent Stretch Type, the Linear Only mode is useful for adjusting 
the range of pixels to match a particular file format. The Log mode is useful 
for compressing the dynamic range of the image, but can be rather harsh. The 
Gamma mode allows you to selectively emphasize bright or dim parts of the 
image by entering a suitable Gamma Value. A Gamma of 1 has no effect, less 
than 1 will emphasize faint details, while a value greater than 1 will emphasize 
bright details.

The Input Range can be set to Screen Stretch, which in Linear Mode pro-
duces an output matching the current screen appearance. This is useful in 
producing final images for output to 8-bit image formats which have limited 
range.  Note that the minimum and maximum values are always taken from the 
screen stretch settings for the original image. These can be adjusted dynami-
cally using, for example, Quick Stretch. The Max Pixel selection sets the input 
range from 0 to the brightest pixel in the image. This prevents any image pix-
els from being saturated in the final result, but may produce images with low 
contrast. You can also manually set values with Manual Settings in a similar 
fashion to the Screen Stretch Window.

The Output Range is used when preparing a file to be saved in a format that 
has limited range. The Output Range maps minimum input to zero, and maxi-
mum input to 255, 4095, or 65535 depending on the settings. Any values that 
exceed the limits are clipped. The Unlimited setting disables all limiting and is 
recommended when performing Gamma and Log stretches; it is appropriate 
when the image will be saved in floating point format.

recommended Processing Sequence
What is the best order to apply the processing functions in? Here is a recom-
mended sequence:

1. Dark Subtract

2. Make Pixels Square

3. Combine

4. Unsharp Mask

5. Color Balance

6. StretchFigure 14: The Stretch command modifies the data contained 
within the image in order to improve contrast and brightness.
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For convenience, you can make pixels square after the combine, unless align-
ment requires rotating the images. If you need to rotate the images by more 
than a small amount, then you should make them square first to avoid geomet-
ric distortion between the frames. 

Once you have the combined frames, there is a lot more room for experimenta-
tion and tinkering. Be sure to save a copy of the combined image; otherwise 
you might have to go back to the beginning and stack individual images 
again!

note on File Format
When saving images (using Save or Save As in the File menu), you have a 
choice of file formats. The default produces .fit files, but .tif, .jpg, .png, and 
.bmp file formats can also be selected. Having a choice of output file formats 
is useful, especially if images will be exported to other software programs for 
additional image processing (like Adobe Photoshop, for instance).

If you save to a file format other than .fit, you will need to check the Auto 
Stretch box, or otherwise Stretch the image to change the Output Range (in 
the Stretch command window) to match the Size Format (in the Save As win-
dow). Otherwise, the Output Range will likely exceed the Size Format, and the 
saved image will be ruined (will turn all white). 

For example, say the Output Range is set to create image brightness values in 
16-bit format, while the Size Format of a specific file format (.jpg, for example) 
may only support 8-bits. Since the 16-bit format sees 65535 brightness levels, 
and the 8-bit format can only support 255 levels, all of the levels above 255 
in the 16-bit image (i.e. the vast majority of the 16-bit brightness levels) will 
be saved at the maximum 8-bit value of 255. So the saved .jpg will have very 
little brightness information from levels 1 to 254 and almost all the brightness 
information at level 255. Thus a white image results.

Other Features
Flip –	Flips	image	orientation.	“Folds”	image	about	vertical	center.

Mirror –	Creates	mirror	image	of	current	image	orientation.

Zoom –	 Increases	 or	 decreases	 level	 of	 image	 magnification	 on	 computer	
screen. When you zoom in too much, you will start to see the squares of indi-
vidual pixels. When zoomed in, you can use Quick Pan; simply hold down the 
Ctrl key, then left-click and drag the mouse on the image.

Night Vision –	Toggles	Night	Vision	mode.	The	red	background	helps	preserve	
your night vision.

Window menu	 –	 These	 functions	 alter	 the	way	multiple	 open	 image	 frames	
are arranged and displayed within Maxim DL Essential. These functions are 
very useful for organizing the visual display when processing large numbers 
of images for stacking.

tips

Focusing
One of the hardest things to do in planetary imaging is achieving good focus. 
You can simply watch the Live Video window to focus, but you can focus “by 
the numbers” on a bright star to get the best focus possible. To do this:

1. In the Camera Control Window, select Light Color 1x1 mode. 

2. Set Frames to 1. 

3. Turn off Dark Subtract. 

4. Now beneath the Mode selector, pick Focus, and then click Expose. The 
camera will take repeated exposures, until you click Stop.

5. If you point the telescope at a bright star, you can focus more accurately 
“by the numbers”:

•	MaxPixel is the value of the brightest pixel in the image. When you are 
in focus, it will be at its highest value. You will need to look at the value 
for several images in succession, because the number will bounce 
around with the seeing. 

Note: If the MaxPixel reaches 255 (in 1 frame capture mode), the image 
is saturated and all three focus numbers will be inaccurate. Either pick 
a fainter star, or adjust the camera’s Exposure settings using the Setup 
button. 

•	 FWHM, or Full-Width Half Maximum, is the width of the star half-way 
down the sides. This provides a highly accurate measurement when 
you are close to focus. When you are at focus, it will be at its lowest 
value. This number will vary due to seeing, so it is best to look at 
several images before decided.

•	HFD, or Half Flux Diameter, is similar to FWHM, but works much better 
than FWHM when the star is badly out of focus. It can produce a 
usable number even when the star looks like a donut. 

Refocus often throughout your imaging session. This ensures at least some 
of your images will have an excellent focus. It is also not uncommon for tele-
scope movements to alter the focus slightly, so be sure to refocus for any new 
astro-imaging targets.

Choosing a Site for astro-imaging
Once you have a focused image, you may find your image shifting and washed 
out. This can be caused by many environmental factors. Poor seeing (move-
ment of molecules in the air, such as heat rising) and poor transparency (mois-
ture, smoke, or other sky contaminants) will all serve to reduce image quality. 
That is why most major astronomical telescopes are on high mountains in thin 
air, to get above much of the seeing and transparency problems. Also, wind 
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will move your telescope and affect images. Your eyes viewing through an 
eyepiece can change slightly to compensate for disturbances like these, but 
the camera can not. Keep these factors in mind when choosing an observing 
site for astronomical imaging.

For the best astro-images, we recommend finding a location with dry air, some 
altitude, and away from city or streetlights. Even a nearby hilltop in the coun-
tryside can provide better viewing conditions than many convenient backyard 
locations.

loss of Camera Connection
If the computer connection to the camera is interrupted, you will need to 
re-establish connection. This can happen due to several reasons; if a cable 
becomes unplugged, the computer “freezes”, or the software/hardware other-
wise temporarily loses the data coming from the camera. 

To re-establish camera connection, first close the Maxim DL Essentials pro-
gram on your computer. Then, unplug and re-plug the camera into the com-
puter’s USB port. Now, open Maxim DL Essentials, and the Live Video should 
appear indicating re-established connection between camera and computer.

using Focal reducers and Barlow lenses
Focal reducers serve to decrease the focal length of your telescope. This 
increases the field of view seen by the camera (decreases camera magnifica-
tion). This can be useful for obtaining images of wider objects, such as the full 
Moon or a landscape vista.

Barlow lenses, or other tele-extenders, increase the focal length of your tele-
scope, which makes the camera field of view narrower (increases camera mag-
nification). This is useful for high-power planetary images. Keep in mind that 
when the focal length is doubled, the image will become four times dimmer, so 
a longer exposure may be necessary.

For best planetary imaging, you should shoot with an effective focal ratio 
(telescope focal length ÷ telescope aperture) of F/20 or greater. This will give 
you a good combination of image brightness and image scale for planets. For 
most telescopes, a barlow lens will be required to obtain this focal ratio. For 
example, Schmidt-Cassegrain telescopes usually have a focal ratio of F/10. 
A 2x barlow lens doubles the effective focal length of the telescope, which 
makes the focal ratio F/20. Similarly, a 3x barlow lens will yield of focal ratio 
of F/30. You can also try using multiple barlows to obtain even greater effec-
tive focal ratios. There is a limit to how large a focal ratio your telescope and 
seeing conditions can handle, however. Experimentation will be needed to see 
what your telescope is capable of in the seeing conditions on a given night. If 
the image appears somewhat dim and fuzzy on the computer screen, you may 
want to consider removing the barlow lens.

Filters
For some types of planetary imaging, you may want to use color filters to bring 
out subtle details. Any standard Orion 1.25" filter will thread into the front of the 
SSSSI’s barrel. Try using several different color filters on a planet to see which 
filters help best show planetary details.

uSB Extension Cable
In many instances, it is likely that a longer cable for the SSSSI will be needed in 
order to comfortably setup telescope, camera, and computer. We recommend 
purchasing a 10' USB extension cable if you need more cord length (available 
through Orion, check the catalog or www.OrionTelescopes.com).

Specifications
Sensor  Color CMOS progressive scan

Sensor size 1/3"

Resolution	 VGA	640x480

Exposure range 0.0001 seconds to 0.5 seconds

Video	frame	rate	 Up	to	30	frames/second

A/D conversion 8 bit

IR filter Yes

USB connection 2.0 or 1.1

Gain	(brightness)	control	 +10	dB

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two condi-
tions: (1) this device nay not cause harmful interference, and (2) this device must accept any interfer-
ence received, including interference that may cause undesired operation.

Changes of modifications not expressly approved by the party responsible for compliance could void 
the user’s authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there is no guarantee that interfer-
ence will no occur in a particular installation. If this equipment does cause harmful interference to 
radio or television reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one or more of the following measures:

•	 Reorient	or	relocate	the	receiving	antenna.

•	 Increase	the	separation	between	the	equipment	and	receiver.

•	 Connect	the	equipment	into	an	output	on	a	circuit	different	from	that	to	which	the	receiver	
in connected.

•	 Consult	the	dealer	or	an	experienced	radio/TV	technician	for	help.

•	 A	shielded	cable	must	be	used	when	connecting	a	peripheral	to	the	serial	ports.



One-Year limited 
Warranty

This Orion StarShoot Solar System Color Imaging Camera is 
warranted against defects in materials or workmanship for a 
period of one year from the date of purchase. This warranty 
is for the benefit of the original retail purchaser only. During 
this warranty period Orion Telescopes & Binoculars will 
repair or replace, at Orion’s option, any warranted instru-
ment that proves to be defective, provided it is returned 
postage paid to: Orion Warranty Repair, 89 Hangar Way, 
Watsonville, CA 95076. If the product is not registered, 
proof of purchase (such as a copy of the original invoice) 
is required.

This warranty does not apply if, in Orion’s judgment, the 
instrument has been abused, mishandled, or modified, nor 
does it apply to normal wear and tear. This warranty gives 
you specific legal rights, and you may also have other rights, 
which vary from state to state. For further warranty service 
information, contact: Customer Service Department, Orion 
Telescopes & Binoculars, P. O. Box 1815, Santa Cruz, CA 
95061; (800) 676-1343.

Orion Telescopes & Binoculars
Post Office Box 1815, Santa Cruz, CA 95061 

Customer	Support	Help	Line	(800)	676-1343	•	Day	or	Evening


